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 1 INTRODUCTION

madCom PC software extends the functionality of madur gas analysers. Among 

other things, it allows to view the results stored in the analyser, process them (print, pre-

pare charts, etc.) It allows to operate with the analyser remotely (from the PC computer), 

to view the currently measured results on the PC monitor and to store them directly on 

the computer to the csv file. madCom software replaces the FGAplus software which will 

no longer be supported. madCom allows to work with the following analysers:

• GA-20

• GA-20plus

• GA-21

• GA-21plus

• GA-21bio

• GA-40plus

• GA-40Tplus

• GA-60

• CMS-6

• Photon (the first generation)

• CMS-7

3

http://www.madur.com/


www.madur.com Manual madCom

 2 MADCOM INSTALLATION

The newest version of madCom software is always available to download from 

madur web-page: http://www.madur.pl/downloadcenter. It is also provided on a CD at-

tached to the analyser. To install the program run the  setup_madCom_v1.1.9.exe pro-

gram and follow the instructions on the screen.

 3 WORKING WITH THE MADCOM PROGRAM

1. After installation, run the program by selecting it from Windows Start menu: Start  

→ Programs → madur → madCom. 

2. madCom  software  works  on  following  operating  systems:  Windows 

95/98/ME/2000/XP/Vista/7, 32 and 64 bit. 

3. When having troubles running the program (especially in Windows Vista / 7 64bit), 

change the Compatibility mode of madCom program:

4. Go to the folder where the program is installed. As a default it is installed in the loc-

ation: “C:\Program Files\madur\madCom”.

5. Right-click on the madCom.exe file

6. Select Properties, and Compatibility tab

7. From the drop-down-list select Windows XP – as it is shown in Drawing 1.

Drawing 1. Changing the Compatibility mode
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After running the program the main window appears – it is divided into three parts  

(shown in Drawing 2.):

 - Quick access bar – chapter 3.2

 - Navigation bar (Side bar) – chapter 3.1

 - Data area. This is where are shown: the online measurement results, bak and 

reports results, graphs, etc.

Drawing 2. Program main window

To start working with the program user must connect with the analyser – Press F8 

function key or  icon from the function bar.

If the COM port is not selected program will open Communication Settings win-

dow – please see more details in chapter4.1.6

Program's functions and adjustment possibilities are described in the chapters 

below.

 3.1 Side panel

The Side panel is divided into four sections: 
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• Operator –  it allows to select a user that currently is working with the device. It is 

possible to add another user, or delete one of the stored users: keys  Add and 

Remove.

Drawing 3. Side panel - Operator

• Disk data – allows to view the contents of the Data folder. It gives direct access 

to the files stored during the measurements. Press Refresh button to update the 

data.

Drawing 4. Side panel – Disk data

• Connected with – this field contains basic info about the analyser that is connec-

ted to the PC.
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Drawing 5. Side panel – Connected with

• Bank measured with  – this field is visible only when online measurements are 

on, or if one of the stored data bank is viewed. It contains information about the 

analyser's equipment during the measurements.

Drawing 6. Side panel – Bank measured with

 3.2 Quick access bar

Drawing 7. Quick access bar.

Quick access bar allows to access the most commonly used functions:

•  Read bank from disk (Ctrl + O)– opens a file stored on a hard disk with banks 

or reports.

•  Save active bank to disk – stores to a file on hard disk, previously opened or 

imported from the analyser, bank or report with measurement data.

•  Restart transmission (F8) – starts or refreshes the connection with the ana-

lyser.

•  Read banks from the analyser (F9) – more details in chapter4.2.1

•  Read reports from the analyser (F11) – more details in chapter4.2.2
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•  Read online (F12) – allows to view (and to store on a hard disk) the results 

currently measured by the analyser – more information can be found in  chapter-

4.2.3

•  Footers  –  Enables  to  edit  the  printout  footers  –  more  information  in 

chapter4.5

•  Fuels – Enables to  view and edit  fuel  parameters  – more  information  in 

chapter4.6

•  Reference conditions – enables to edit the coefficients used for recalculating 

results from mg to ppm – more information in chapter4.8

All the aforesaid functions are also available from the main menu bar.

 3.3 Main menu bar

Above the quick access bar there is the main menu bar that contains all the avail -

able in this program options.

Drawing 8. Main menu bar

Each  function  available  in  the  program is  described  in  the  chapter  4 of  this 

manual

 4 MADCOM FUNCTIONS

In this chapter all available functions in madCom program will be explained. They 

are described in an order they appear in the main menu bar.
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 4.1 File

Drawing 9. Functions available in the File sub-menu

 4.1.1 Open

Function File → Open allows to open madCom data files. Available files exten-

sions:

• *.bnk – bank file, i.e. storage of the continuous measurements. They are stored in 

the \Data\Bank folder. This folder also contains  Bank Set file, which saves the 

analyser's memory contents. Depending on the device it may have different ex-

tension:  *.bks, *.bk6, *.bk5, *.bk2.  Those files are created on the hard drive 

while reading the data from the analyser.

• *.rps – data containers stored in the analyser as a report.

• *.bmp – Printscreens of the analyser's display taken during the Remote Control 

mode.

• *.csv – data exported to the CSV files. CSV files are readable by spreadsheet ap-

plications, like Microsoft Excel or OpenOffice Calc.

*.ftr – these are the footers added to the printouts.

 4.1.2 Save

Allows to save changes in the edited bank file (*.bnk). This option is applicable 

only to the previously saved files.
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 4.1.3 Save as...

Allows to save data read from the analyser or from the open Bank Set file to a 

new *.bnk file.

 4.1.4 Export *csv

Allows to store data in a csv file, which is readable by spreadsheet applications 

(like Microsoft Excel or OpenOffice Calc). This option allows to export data from *.bnk, 

and *.bks files. When selected, it opens a window where one can chose which data to ex-

port. All On/Off selects or deselects all fields. Selecting Shortform export, exports only 

measurement data. Information about the operator, device, fuel and measurement para-

meters are ignored. „Export *.csv” opens a window where one can select a destination 

folder and the csv file name.

Drawing 10. CSV export options window.

 4.1.5 Restart transmission

Starts the connection between the analyser and the PC via the selected RS-232 

port. If the analyser is already connected, the connection is terminated and started again.

If, during the connection attempt, no analyser will be connected to the PC, an er-

ror message will appear.
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Drawing 11. Error message – no connection with the analyser

If the error repeats, check the communication options – see if the selected COM 

port number corresponds to the port number where the cable is connected to.

 4.1.6 Options – Communication Settings

Options available from  File → Options allows to adjust the communication port 

settings. 

Drawing 12. Options – communication settings.

In the  Port section one must specify the serial COM port that will  be used for 

communication with the analyser. In the  Speed limit section one must select the baud 

rate. Maximal possible baud rate is depended on the device connected to the computer – 

see the table below:

Anaylser 9600 19200 38400

GA-20 plus X

GA-21 plus X

GA-40 plus X

GA-40T plus X
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GA-60 X

CMS-6 X
Tabela 1. Baud rate for different analysers.

In Online measurements section one can adjust:

• Interval between measurements – how often the results are read from the ana-

lyser (and stored on the disk), expressed in seconds or minutes. The maximal in-

terval is 30 minutes.

• Lock the analyser's keyboard during the online – if this option is selected the 

analyser will not react to the pressing of keyboard keys. 

• Automatically stars saving the online results to CSV file  – when this option 

is ON the program automatically starts storing the results to a CSV file on a hard 

disk (in the program's installation folder \Data\Online\).

If this option is OFF it is still possible to save the results to a file by selecting an 

option Save results to CSV – as it is shown in the  Drawing 13.

Drawing 13. Save results to CSV file

• When resuming CSV storages, always add a new heading – during the online 

storages it is possible to discontinue the storages results to a file (by unchecking 

the option shown in the Drawing 13.) If this option is on then the resume of stor-

ages will add a new heading in the csv file.

Stopping the online measurements always ends the csv file. Starting the 

online measurement again creates a new csv file.
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• Automatically detect analyser after start –  when the program runs it starts to 

communicate with the analyser automatically.

• Check for presence of GA-20 / GA-60 / Sensonic 2k / Photon – program is de-

signed to cooperate with different  madur analysers.  Its default  communication 

protocol is set to communicate with GA-21plus / GA-40plus / GA-40Tplus analys-

ers. If the program is to communicate with different analyser it must be selected 

from this list.

 4.1.7 Language

Allows to change the program language. If  your language is not listed, please 

contact madur to receive language file for translation. As soon as we have this file trans-

lated we prepare your language version of madCom program.

 4.1.8 Quit

Ends the program and shuts it down.

 4.2 Results

Drawing 14. Functions available from Results sub-menu.

 4.2.1 Read banks from the analyser

This option is available only when the analyser is connected to the PC. It reads 

data banks from the analyser and shows them on the screen. During the readout the 

Bank set file is also created ( *.bks, *.bk6, *.bk5, *.bk2 depending on the device type).  

Each data bank opens in a separate window. Each can be saved to disk as a  *.bnk file.  
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Drawing 15. Information about the bank read from the analyser

The upper left part of this window is an informative part, that contains:

• Date, time of the measurement and it's length

• Number of single measurements

• Bank name – e.g. customer's name

• Info – additional information, comment, etc.

• Fuel – fuel parameters, that will be considered during the results calculation.

Drawing 16. Bank – Informative part 

It is possible to print the bank contents. Print button opens the window with prin-

tout options (see Drawing 17.).
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Drawing 17. Printout options window

Drawing 18. Windows with data, read from the analyser's bank.

Choice of view (upper right part of the window) allows to switch between different 

views of the data from the bank / online measurements. The following view types are 

available: 

• Single – shows detailed information about selected measurement:

• Averaged – averages the result for the selected measurements

• Chart – results are presented in a graphical form.
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Drawing 19. Results presented in a graphical form

Chart window contains additional options (small icons above the graph):

• Zoom chart to full screen (Ctrl + Z) – opens the chart in a larger window (as it is  

shown in  Drawing 21.)

• Chart settings (F5) – Opens a window with charts options. This is where one can 

select which values are presented in the chart, change its colour, or change the 

chart's scale. 

Drawing 20. Chart's settings

The right side part of chart settings window allows to change the chart's scale:

• Auto – the scale is adjusted automatically

• Manual – user can set the scale according to own needs.

• 1-2-5 – the borderline values of the scale are the multiplications of num-

bers 1, 2 5

On the left there are options that allow to show / hide variables in the chart and al-

low to adjust the colour of the variable

• Chart printing

• Show / hide legend
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• Thick lines

Drawing 21. Chart in a full screen mode

All the aforesaid charts options are also available from the  Main menu → View 

sub-menu.

 4.2.2 Read reports from the analyser

This option is active only when the analyser is connected. If the analyser contains 

reports a following window appears:

Drawing 22. The readout of the reports from the analyser's memory.

This window contains information about the report's heading and the date when 

the report was taken. To read the report's contents the report must be added to a data-

base first – button Add to database.
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 4.2.2.1 Opening database

To view the contents of a report one must open a database file where this report 

is assigned to (see the chapter4.2.2). From the side panel, from the  Disk data section 

(see Drawing 4.) single-click a database to open it. The following window appears:

Drawing 23. Data read from the database.

The bottom part of the window contains a list of reports in the opened database. 

On the right in the Visible columns section, user can select which values are shown and 

can be printed. 

From this window it is possible to modify the header, rename the database or to 

delete the database file from the hard disk.

 4.2.3 Read online...

Online measurements are available from the  Main menu bar:  Results →Read 

online... or by pressing the  icon from the Quick access bar or by pressing the F12 

function key. During the online reading, the results from the analyser are presented on 

the PC monitor, and if proper option is selected, they are stored into csv file on a hard 

disk. Options related to the online reading are available from Options – Communication 

settings window (see chapter4.1.5for more details).
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Drawing 24. Online measurements.

Online reading is similar in its functionality to bank readout from the analyser. 

User can view single result,  averaged results (see chapter4.2.1) or to view them in a 

graph form (see Drawing 19.)

During the online reading it is possible to stop / resume the storage of the results  

into the csv file by selecting the option shown in the  Drawing 25.. To stop the online 

measurements press Stop online button in the Side bar panel (see Drawing 26.)

Drawing 25. Stop / resume online storage into csv file
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Drawing 26. Stop online readings

Drawing 27. Warning announcement before stopping the online measurements

 4.3 View

Drawing 28. Functions available from the View submenu

This options is available only when viewing the contents of reports and banks. It 

allows to adjust the data presentation in tables and on the graph. Available functions are 

described in chapter4.2.1.

 4.4 Remote control

This option allows to remotely (on the PC monitor) view the contents of the ana-

lyser's display. It also allows to send the commands to the analyser as they were evoked 

from the analyser's keyboard. Button  Capture display contents creates a bmp file on 

hard disk (in \Data\Display directory) with a copy of the display's image.
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Drawing 29. Remote control panel

 4.5 Footers

This function allows to create or edit the footers used in the printouts. It is pos-

sible to access this option be single-clicking a  ftr file in the  Footer folder from the side 

panel.
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Drawing 30. Footer editor

The Footer editor's options:

• Open – opens ftr file with footer definition from the hard disk.

• Save – save changes in the edited footer.

• Save as – saves the footer definition in a different file.

• Read from... – read the footers from the analyser.

• Send to... – send the edited footer back to the analyser.

• Delete file – deletes the edited footer from the hard disk.

• Clear all – clears all the line in the edited footer.

It is possible to import / export footer from / to txt file. Opening txt file from the 

side panel (form the Footer folder) opens footer editor:

Drawing 31. Editing footers from the txt file.

 4.6 Fuels

This option allows to edit fuel parameters. It is important to use the correct fuel  

parameters as they are used for calculation made by analyser. Selecting Fuels, the fol-

lowing window is opened:
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Drawing 32. Fuel parameters window

Fuels highlighted in blue are predefined by manufacturer  and they cannot  be 

modified. Fuels highlighted in white are user-defined and are freely editable. User can:

• delete a fuel (applicable only to user-defined fuels)

• add a new fuel

• send fuel to / read fuel from the analyser's memory (true only to the Photon gas 

analyser)

 4.7 Import reports from Photon SD / MMC card

Drawing 33. Import reports from Photon SD / MMC card

Photon analyser is equipped with SD / MMC card reader where measurement re-

ports are stored. This program's option allows to import reports stored on the SD / MMC 

card.

 4.8 Reference conditions

Here is where it is possible to define coefficients used for recalculating the results 

from ppm to mg. Button Default restores the factory set values. 
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Drawing 34. Defining coefficients used for recalculating results from ppm to mg.

 4.9 About

Drawing 35. Information about the program.

This option displays information about the program – version, manufacturer, etc.
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 5 USING MADUR USB-TO-RS232 CONVERTER

The standard cable for communication with the madur analysers is “true” RS-232 

cable. RS-232 is an industrial standard that provides stable, resistant to errors communic-

ation for long distances (even up to few hundred meters). 

Drawing 36. “True” RS-232 communication cable

Because nowadays personal computers, especially laptops, are rarely equipped 

with RS-232 ports, madur offers its clients optional USB-TO-RS232 converter cable. This 

cable is build using the best quality parts, that provides the best communication stability.

Drawing 37. madur USB-TO-RS232 converter cable

As in case of most USB equipment, madur cable requires drivers for proper work. 

Suitable  drivers  are  included  in  the  madur  software  CD,  in  the  service_madur_USB 

folder. They are also available from website: http://www.ftdichip.com/Drivers/VCP.htm. 
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Detailed manuals concerning installation of USB drivers in different Windows plat-

forms  can  be  found  here:  http://www.ftdichip.com/Support/Documents/In-

stallGuides.htm 

To check if the installation of USB cable was successful, please go to  Control  

Panel → System → Device Manager and see if there is a USB Serial Port entry in Ports 

(COM & LPT) nod. Number in brackets (in the picture below it is COM3) specifies the 

COM port assigned to the madur USB-TO-RS232 converter cable – this COM port should 

be selected in the madCom program in the Communication Settings window – for more 

details see chapter4.1.6.

Drawing 38. USB-TO-RS232 converter successfully installed.
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